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Software Update Release Notes: GSG StudioView® Scenario Builder Software 

GSG StudioView Version 5.6 Release Notes  
 

Safran 

Rochester NY, USA 

August 25, 2023 

 
GSG StudioView offers an easy way to create, edit and back-up complex scenarios for a Spectracom GSG Series multi- 
channel GPS/GNSS simulator. 

 
StudioView software now requires no license (from Version 5.5.1.3). Premium features require additional licensing on 
the GSG unit. Any particular feature may be limited by the GSG hardware. 
 
Improvements in version 5.6 

Version 5.6.0.1 – August 25, 2023 
o Updated default browser to support Google Maps 

 
Improvements in version 5.5 

Version 5.5.1.5 – February 17, 2022 
• General: 

o Fixed issue with Google Maps after latest Google Maps update 

• eCall/UN R-144 tools: 
o Maximum pause after first solution in eCall test 2.7.7 increased 

Version 5.5.1.3 – October 25, 2021 
• General: 

o StudioView no longer requires a license key. 
o Removed registration window, Help menu registration, registration info from About window. 

Version 5.5.1.2 – September 29, 2021 

• Scenario Editor 
o Fixed a bug that caused duplicate satellites to appear in the satellite preview 

• RSG Editor: 
o Corrected issue that could cause an error when first command did not contain a duration 

Version 5.5.1.1 – September 2, 2021 

• eCall/UN R-144 tools: 
o Allow setting of external attenuation up to 60dB. 

Version 5.5.1.0 – September 1, 2021 
• General: 

o Support for GPS L1C signal (in Scenario editor, Events editor, data messages decoding) 
o Fixed unit identification problem when connecting to units with very old firmware (below 4.07) 
o Added example scenario and RINEX files with support of Beidou PRNs > 37 (folder- 

Repository/BeidouHighPRNs). 
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• Scenario Editor 
o RINEX files downloading: corrected URLs to the files on CDDIS server after files extension change at 

Dec 1, 2020. 
o Satellites preview: support Beidou PRNs > 37. 
o Fixed: when navigation data didn't contain timescale conversion info for specific system satellite 

preview could show no satellites. 
o Show information about baseline distance in RTK tab 
o Mark legacy RTCM messages as "legacy" on RTK tab 

• RSG Editor: 
o Support export to CSV format for Skydel simulator (File->Export). 
o Possibility to disable automatic trajectory recalculation on every change in trajectory (for complex 

long trajectories) 

• eCall/UN R-144 tools: 

o Allow to set external attenuation up to 50 dB. 
o Support advanced filtering of incoming receiver data by user-defined patterns. This is for devices 

outputting a mix of NMEA data together with their internal logs. 

• RTCM transmission tool: 
o Added NTRIP server/caster. 

Improvements in version 5.4 
Version 5.4.4.2 – December 4, 2020 

• General 
o Minimum required version of the .NET Framework is 4.7 
o Minor design update of Application tips page. 

• Scenario Editor 

o Support for RTCM message types MSM3 and MSM7, added descriptions for each available message. 
o Added button "Copy base station coordinates from scenario start position" in RTK tab 
o Support new protocol (FTP-SSL) for accessing CDDIS ftp site when downloading navigation data. 
o Added more sources of GPS navigation data (in addition to CDDIS): 

- gssc.esa.int 
- igs.ensg.ign.fr 
- serenad-public.cnes.fr 
- ftp.glonass-iac.ru 

• RTCM Transmission tool 

o Possibility to log RTCM messages to a file. 
o Removed message "Operation completed successfully" at the end of RTCM transmission. 

• Trajectory Editor 
o Allow entering speeds higher than 520 m/s. OPT-HV is still needed to support such speeds on unit. 
o Save 8 digits for latitude and longitude in NMEA, instead of previously 4. This allows to get smoother 

trajectory, especially when downsampling/smoothing/interpolation was applied. 

• Events editor 
o Bugfix in Multipath event editor: relative power value was initialized to relative Doppler value when 

the editor was opened. 

• Spoofing tool 
o When using multi-signal scenarios respect signal power offsets when doing power change (requires 

firmware v8.2.1) 

• Data Recorder 
o Satellites log - added support for L1 phase range (firmware v8.2.1 is required). 
o Fixed: Data recorder could open redirection com port even when redirection was not activated. 
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• Accident Emergency Call Systems Tools 
o Fixed: position error chart picture was empty in the log. 

 
Version 5.4.3.0 – June 15, 2020 

• Scenario Editor 
o Support for B1C, B2a and B3I signals (GSG firmware version 8.1.1 is required) 
o Added support of new download location for Galileo ephemeris - ftp://serenad-public.cnes.fr 
o Added support for DO-229 tropospheric model selection 

• Data Recorder 
o Interface layout update and UI performance optimizations 

▪ Text logs moved to separate tabs 
▪ Improved layout for small screens 
▪ Advanced features (like data redirection) moved to a separate section 
▪ Added smart auto scroll of text logs 

o Improved accuracy of 3D position errors by using HAE height for calculation rather than MSL 
o Added ability to log and save position errors 
o Now time axis in graphs correspond to scenario time instead of time relative to recording start 
o Additional options to restart currently running scenario and stop scenario upon recording 

completion 

• Accident Emergency Call Systems Tools 
o For Galileo-only test added 1 minute wait after GPS is disabled to verify receiver is really operating 

in Galileo only mode and test does not return a false pass indication 

• Event Editor 
o Page parameter of navbits event is not relevant for GPS CNAV (GPS L2C, GPS L5). Now it will not be 

displayed. 
 

Improvements in version 5.3 
Version 5.3.1.1 – January 8, 2020 

• General 

o NI-VISA download removed from installer and a link provided instead 
• Scenario Editor 

o Corrected the position of the base station displayed when read from scenario file 
o Improved satellites preview – satellites under the elevation mask are now shown with red circles 

• Data Recorder 

o Removed the RSG compatibly checkbox, this is determined automatically based on firmware version 
o Updated skyplot to support single and multi-frequency receivers 

• Accident Emergency Call Systems Tools 
o Added option to ignore inaccurate positions for a fixed period immediately after first fix 
o Added option to allow missing NMEA sentences during a fixed period immediately after first fix 

without causing the test to fail 

• Trajectory Editor 

o Increased NMEA point default limit to 50,000 
• Event Editor 

o Added support for editing SBAS L5 navbits events 

• Spoofing Tool 
o Improved synchronization of 2 GSGs in the VTS system 
o Position offset can be entered using east, north, and up offsets instead of a single north only offset 

ftp://serenad-public.cnes.fr/
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Improvements in version 5.2 
Version 5.2.6.2 – May 8, 2019 

• General 

o Default navigation data updated for Beidou and NavIC 
o Pressing an icon button from the toolbar shows open windows for that tool and allows selection of 

open window, or create a new window 
o Toolbar is cleaned up so only commonly used icons are available. All tools are still available from the 

Tools menu. 

• Scenario Editor 

o Added additional error messages to satellite preview if an error occurs 
o Added SBAS L5 support 
o Beidou RINEX file extension is standardized to .XXc rather than .XXf 
o Rarely used selections for external models are hidden by default on navigation tab. Can be re- 

enabled in the setting menu. 

• Data Recorder 
o NMEA sentences from receiver with invalid fix sign or without time/date fields filled will be ignored 

without processing 
o Rejects positions from NMEA RMC and GGA messages when their validity status is bad 

• File Manager 

o Does not disconnect GSG from StudioView if VISA error occurs 
• Accident Emergency Call Systems Tools 

o Added workaround for wrong GPS date detection by receiver due to week rollover 
o Fixed error message “unknown mode Combined” when “receiver needs GPS” is enabled 

• Console 
o Prevent freeze after text is pasted in after being copied from another application 
o History is saved even for mistyped or commands that result in an error 

• Event Editor 
o Added support for new event target for ABSPOWER and RELPOWER events – satellite system 

• Spoofing Tool 
o Added wait cursor when starting spoofing tool to avoid accidently stopping tool just after starting it 

Version 5.2.3.2 – December 10, 2018 

• Scenario Editor 
o Corrected error in satellite preview for default data when scenario start time was between 00:00 

and 03:00 on a Thursday 
o Satellite preview file loading optimized 
o Added satellites preview support for BDS and QZSS 
o Added support for comments in scenario file 
o Added display of MSAS files in navigation data selection window 

• Data Recorder 
o Added support for raw HEX string logging for: 

▪ GPS L2C, L5 
▪ GLONASS L1, L2 
▪ Galileo E1, E5a, E5b 
▪ QZSS L2C, L5 
▪ IRNSS L5 
▪ SBAS 
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• Accident Emergency Call Systems Tools 

o Added new tool for UN R-144 Testing 
o Added reset button ‘R’ to reset numeric and timespan controls to their default values 

o Added skyplots to eCall and UN R-144 testing tools 
• Uploader 

o Added checkbox to automatically select uploaded scenario on simulator 

• Event Editor 
o Added support for comments in events file 

Version 5.2.1.4 – October 1, 2018 

• General 

o StudioView is now branded as Orolia 
o Changed StudioView icon 

• Scenario Editor 
o Added support for downloading MSAS message files 
o If a downloaded file is empty user is notified 
o Selection of specific SBAS satellites is supported 
o SBAS files will only be downloaded for selected satellites 
o GPS to UTC Offset can be specified in the scenario editor 
o Elevation mask range extended to [-89.9,89.0] 

• Trajectory Editor 
o Simplified creation of a looping trajectory 
o Fixed Googles Maps browser incompatibility false error 

• Data Recorder 
o Added BeiDou D1 and D2 subframe logging 
o Corrected layout of some controls 

• eCall Compliance Testing Tool 
o Fixed false detection of time jumps from pairs of NMEA sentences with different talker IDs 

• Event Editor 
o Allowed page ID to be set to zero instead of only 1...25. 

Improvements in version 5.1 
Version 5.1.8.2 – March 19, 2018 

• Scenario Editor 

o Correction to ephemeris needed calculation when downloading data 
• Trajectory Editor 

o Corrected bug that caused last point to always have speed of 10m/s 
• eCall Compliance Testing Tool 

o Added support for Galileo-only scenario with first fix by GPS 
o Added support for eCall 2.1.1 NMEA message checking 
o All time scales are reported as UTC, previously some were GPS 
o Added possibility to copy text to clipboard from test log 
o Recording of receiver Raw data along with NMEA for system debugging added 
o Added possibility to use additional COM port or external executable (or script) to perform cold start 
o Delay added before antenna disconnection in sensitivity test 
o Improved NMEA parsing for the cases when NMEA is mixed with other non-NMEA data and not fully 

compliant with NMEA standard 
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o NMEA GSV parsing improvement: azimuth, elevation and snr were parsed as ints, but some 
receivers may output them as decimals 

• Data Recorder 
o Improved NMEA parsing for the cases when NMEA is mixed with other non-NMEA data and not fully 

compliant with NMEA standard 
o NMEA GSV parsing improvement: azimuth, elevation and snr were parsed as ints, but some receivers 

may output them as decimals 

• Scenario Generator 
o Fixed: if source NMEA contained NMEA PRNs for different GNSS, but with overlapping ranges, they 

could be not distinguished as different satellites 

• Repository 
o Updated default navigation data (aligned with 7.1.5 firmware release) 

Improvements in version 5.1 

Version 5.1.8.2 – March 19, 2018 
• Scenario Editor 

o Correction to ephemeris needed calculation when downloading data 
• Trajectory Editor 

o Corrected bug that caused last point to always have speed of 10m/s 
• eCall Compliance Testing Tool 

o Added support for Galileo-only scenario with first fix by GPS 
o Added support for eCall 2.1.1 NMEA message checking 
o All time scales are reported as UTC, previously some were GPS 
o Added possibility to copy text to clipboard from test log 
o Recording of receiver Raw data along with NMEA for system debugging added 
o Added possibility to use additional COM port or external executable (or script) to perform cold start 
o Delay added before antenna disconnection in sensitivity test 

• Improved NMEA parsing for the cases when NMEA is mixed with other non-NMEA data and not fully 

compliant with NMEA standard 

• Data Recorder 
o Improved NMEA parsing for the cases when NMEA is mixed with other non-NMEA data and not fully 

compliant with NMEA standard 
o NMEA GSV parsing improvement: azimuth, elevation and snr were parsed as ints, but some 

receivers may output them as decimals 

• Scenario Generator 
o Fixed: if source NMEA contained NMEA PRNs for different GNSS, but with overlapping ranges, they 

could be not distinguished as different satellites 

• Repository 
o Updated default navigation data (aligned with 7.1.5 firmware release) 

 

Version 5.1.4.0 – December 19, 2017 

• Scenario Editor 

o Default start date is 1 month in the past 
o By default, only GPS L1C/A signals are enabled, others must be selected 
o Default duration is 1 hour, instead of 5 minutes 
o Added option to make the scenario length equal to the trajectory length 
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• Event Editor 
o Allows event file to open with empty lines 

• eCall Compliance Testing Tool 
o Added new tool to support OPT-ECL 

• Data Recorder 
o Improved error reporting 

Improvements in version 5.0 
Version 5.0.2.0 – July 19, 2017 

• Scenario Editor 

o Support for Galileo E6 signals 
• Console 

o History no longer remembers automatically executed commands 
• Data Recorder 

o Navigation data logging only enabled when box is checked 
o Fixed a serial port exception when no serial port selected for receiver 

• Spoofing Tool 
o Noise is set to off on both GSG units when starting setting power levels 

Improvements in version 4.7 
Version 4.7.5.2 – February 14, 2017 
• Scenario Editor 

o Fixed the interference mode selection to align with the modes in the GSG 

• Data Recorder 
o Added scrollable panel to make it more usable on small screens 
o Added support for logging navigation data message 

Version 4.7.1.0 – November 2, 2016 

• Scenario Editor 

o Added optional flag to remove power offsets between constellations in a scenario 
o Fixed exception that could occur when configuring interference signals 

• Event Editor 
o Fixed deletion of multiple events 
o Corrected ordering of events 

• Data Recorder 
o Added support for new log types – RSG log and Satellite Log 

• Spoofing Tool 
o Added possibility to have different trajectories and date/times on the 2 GSG units 

Version 4.7.1.0 – July 11, 2016 

• Event Editor 
o Added configuration parameter to absolute noise adjustments to adjust power only, not noise 

Improvements in version 4.6 
Version 4.6.1.3 – June 2, 2016 

• Google Maps Tools 
o Updated Google Maps API version after support for current version was removed 
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o Google Maps interface is no longer supported for Windows XP and Windows VISTA 

Version 4.6.1.2 – April 22, 2016 

• Scenario Editor 

o Fixed an issue downloading compressed files 
o Increased precision for entry of ECEF coordinates 

• Spoofing Test 
o New tool to support control of the Vulnerability Test System 

Improvements in version 4.5 
Version 4.5.1.4 – December 21, 2015 

• RSG Trajectory Editor 
o Fixed Kepler Orbit parameters to correctly display 6 input parameters 

Version 4.5.1.3 – September 14, 2015 

• Scenario Editor 

o Added support for new environment propagation models 
o Preview satellites can show satellites when using default ephemeris data 

• Scenario Generator 
o 4000-line limit for event files has been removed 

• RSG Trajectory Editor 
o Added Copy/Paste operation 
o Simplify Trajectory will remove overriding RSG commands 

• Trajectory Editor 
o Better support for recorded NMEA trajectories with discontinuities 

• Data Recorder 
o Added ‘Speed over Ground’ graph 

• Event Editor 
o New event added to change environment propagation model during scenario run 

 
Improvements in version 4.4 

Version 4.4.1.5 – May 27, 2015 
• RSG Trajectory Editor 

o Renamed tool from Realtime Trajectory Editor to RSG Trajectory Editor 
o New Maneuver options for Turning and Acceleration 
o Added support for TURNRATE, TURNRADIUS commands 
o Added support for Kepler Orbits 

• Trajectory Editor 
o Added option to add elevation to route 

• Scenario Editor 
o Support for IRNSS L5 
o Support for QZSS L2C and L5 
o Added option to preview satellites to be generated when using user-selected RINEX files 
o .cnt (CNAV message) files can be selected in the Navigation data selection tool 
o Updated default GPS constellation 
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• Data Recorder 
o 2D/3D error graphs are displayed when receiver NMEA and GSG NMEA are both available. 
o Accepts nmea in and converts to RSG commands in real-time 

• Repository 
o Added ERA GLONASS Test Set – scenarios and files to support ERA GLONASS testing 

Improvements in version 4.3 
Version 4.3.0.6 – April 13, 2015 

• File Manager 
o Fixed SRQ error that could occur when trying to transfer files from GSG 

• Data Recorder 
o RINEX NAV logging command is sent before ARMing the unit 

• Uploader 
o Corrected error that occurred when updating from firmware prior to 6.3.1 

Version 4.3.0.4 – February 23, 2015 

• Scenario Editor 
o Navigation data selection grouped by constellation and type 
o Support for selection of precise orbit files (.sp3) 
o Constellation Editor moved from tab to button, improved satellite selection 
o Support added for QZSS and IRNSS navigation file selection 

• RINEX Editor 
o Allows editing of TDG 

• Data Recorder 
o Log RSG data to file 
o Shows position of simulated signal and positon of receiver signal on the map 

• Events Editor 
o NAVBITS support for Galileo signals 

• Realtime Trajectory Editor 
o Implemented rhumb line calculation 
o Fixed version of Google Maps API to version 3.19 

 
Improvements in version 4.2 

Version 4.2.5.1 – December 19, 2014 

• Added Antenna Pattern Editor tool 

• Scenario Editor 
o Added visualization of selected antenna pattern 
o Support for QZSS L1 SAIF selection 

• Console 
o Added automatic checking of GSG error queue after every command (includes ability to disable) 
o Improved Loop command to include error checking 

• Web Interface 
o Links clicked on from web interface within StudioView now open in default browser 

• Event Editor 
o NAVBITS support for BeiDou, QZSS , SBAS signals 
o Support for improved multipath commands added, MULTIPATH, DUPLICATE, DELETE 
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• Data Recorder 
o Speed and height graphs update again in real time 

• Trajectory Editor 
o Jammer visualization radius is limited to 5000km 
o Improved Route Builder response time when entering an address 
o Improved response when adding a new point at the end of a long trajectory 

• Realtime Trajectory Editor 
o Fixed bug in displaying vertical speed and acceleration on graphs 

Version 4.2.0.1 – October 31, 2014 
• Updated StudioView Icons 
• Added Tooltip panel on the bottom of main window 

• Added RINEX editor 

o Allows editing of 
▪ Ionospheric correction 
▪ Time correction 
▪ Leap Seconds 
▪ Satellite health 

o Allows removal of unwanted satellites 
• Scenario Editor 

o Added support for new GSG features 
▪ QZSS L1 C/A selection 
▪ Vehicle Model file selection 
▪ Lever Arm 
▪ STANAG troposphere model 
▪ IONEX ionosphere model files 

o Graphical visualization of jammer positions on maps* (OPT-JAM) 
o Updated resolution for swept interference start and end offset to 1Hz* (OPT-JAM) 
o Navigation files from repository no longer display full paths 
o Upper limits for multipath ‘power change’ and ‘power offset’ parameters changed to +6 dBm 
o RandomMpCP parameter for multipath is now selected for the entire scenario 

• Events Editor 
o Support for NAVBITS event (for GPS and GLONASS satellites) 

o Range of duplicate event relative power changed to [-30, +6]] 
• Trajectory editor 

o Added undo/redo function 
o The points table will show "<0.1" for altitude and height for values not zero but less than precision 
o Improved operation of when used without internet access 
o Fixed a bug that caused NMEA files of 24+ hours long to be loaded incorrectly 
o Fixed: a bug in down sampler that incorrectly rejected point in the trajectory 

• Real time Trajectory Editor 
o Added undo/redo function 
o Fixed: PRYATTITUDE command editor previously showed wrong units 'rad/s' instead of 'rad' 
o Removed support for POWER command 
o Fixed crash on entering values close to +/- Pi in PRYATTITUDE RSG command editor 
o Fixed: Velocity and altitude graphs could previously fail to display curves in certain situations 
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• Data Recorder 
o Support for QZSS satellites on sky plot 

• Scenario Generator* (OPT-RP) 
o Fixed: Scenario Generator didn't process NMEA files with no GGA messages. 
o Added for support for GLONASS 
o Initial power level for untacked satellites set to -160 dBm 

• Uploader 
o Better error reporting when uploading unsupported file types 

Improvements in version 4.1 
Version 4.1.1.4 – July 18, 2014 

• Added StudioView Help 

• Removed Getting Started window 

• Corrected a bug that caused the Connections Manager to scan for devices too often 

• Updated Application Tips 

o Main functions can now be opened from Application Tips 

• Scenario Generator* (OPT-RP) 
o Updated N0 thermal noise default value to -172dBm/Hz 

o Added SNR threshold change to limit number of events generated 
▪ Number of events accepted by GSG is now 4000 

o Turns power down on satellites listed in Navigation data but not in NMEA file 

• Trajectory editor 
o Added timestamps to the trajectory editor 
o Allows stationary periods to be added during the trajectory 
o Improved trajectory speed and altitude smoothing 
o Trajectory converter provides Max Acceleration as a new smoothing parameter 
o Improved multiple points editing 

• Scenario Editor 
o Dropdown lists now display the Scenario save location 
o Added support for RandomMpCP keyword to scenario editor (multipath carrier phase 

randomization) 
o Support for Jamming features in the scenario generation* (OPT-JAM) 
o Added support for selecting ENV files (.kmz) in scenario* (OPT-VIS) 
o Improved selection of Navigation data, more than one file can be selected at once 
o Added support for selection of Galileo and BeiDou RINEX files 

o RTK tab allows setting of base station coordinates and enabling of RTCM messages 
o YUMA almanac are supported and can be selected in the Navigation data for the scenario 
o WAAS files are supported without extension 

• RSG Trajectory Editor 
o Visual display of trajectory during editing 
o Added plots to display altitude and speed changes over time 
o Drag and drop editing of commands in table 
o Added zoom to trajectory for Google Maps view 

• File Manager/Uploader 
o Support for ENV file transfer and uploading* (OPT-VIS) 
o Supports transfer of calibration files* (OPT-TIM) 
o Supports uploading of YUMA almanac 
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o Fixed -190 error message that could occur when trying to transfer files when unit is running a 
scenario 

o Provides a warning if wrong file type is placed in wrong folder 
• RSG Player 

o Controls the scenario start/stop to synchronize time the commands are sent* (OPT-RSG) 

• RTCM Transmission* (OPT-RTK) 
o Routes RTCM messages to COM port 
o Allows configurable polling interval and delay of RTCM messages 

• Data Recorder 
o SiRF USB receiver is configurable from StudioView 
o Can display data without recording to file 

• Web Interface is accessible through StudioView 
 
Improvements in version 4.0 

Version 4.0.0.6 

• Trajectory editor 
o Route builder allows adding of intermediate points 
o Added plots for speed and altitude 

• Data Recorder 
o Added view screen to show map, skyplot, and plot charts while recording NMEA 

• Added support for user selected Galileo and Beidou navigation files in Scenario Editor 

Version 4.0.0.5 

• Data Recorder 

o Asks if you wish to stopping the running scenario when stopping a recording 
o Assists in logging observation and navigation rinex files, and YUMA almanac. 
o Redirects NMEA to COM port 

• New in the settings menu, AutoConnectToLastUnit – allow StudioView to automatically connect to the last 
connected unit 

• Added support for Galileo and BeiDou events and interference signals 

• Fixed a bug in the Scenario Editor coordinate presentation 

Version 4.0.0.4 

• Added Record and Playback function 
o New Data Recorder feature 
o New Scenario Generator Feature 

o Added support for SBAS files 
o Downloading 
o File selection and transfer from repository 

• Added support for BeiDou in the scenario editor 

• Improved trajectory position transfer to scenario file 
o Altitude is now included 

Improvements in version 3.5 

• Introduced presets for trajectory smoothing parameters 

• Added Galileo support in scenario editor 

• StudioView will accept NMEA sentences with checksum errors to allow for manual NMEA editing 
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• Improved connection when errors exist in the GSG error queue 

• StudioView provides warnings when NMEA trajectories are created that exceed the limits of the GSG. 
 

Improvements in version 3.1 
• Added down sampling capability to trajectory converter 

• Added trajectory smoothing tool to the trajectory converter 

• Updated the constellation editor 

o to utilize the default types 
o All satellites are now listed 

• Scenario uploading improvements 
o Scenario can now be uploaded directly from scenario editor 
o StudioView messages show what files were uploaded when file upload is complete 

• RSG editor improvements (premium feature) 
o The same time format is now used in all places 

Improvements in version 3.0 

• Support added for L2C and L5 signals 

• Added GPS and GLONASS constellation editor for SV types 

• Trajectory editor will work even when offline, Google Maps will just not be loaded 

• Added possibility to edit RSG commands (premium feature) 

• RSG editor improvements (premium feature) 

o Shows full command 
o Respects resolution of each parameter as specified in SCPI handbook 

Improvements in version 2.5 

• Save NMEA log to file; you can use this function by selecting "Tools->Data recorder" 

• StudioView now downloads exactly the same data as GSG do (including 3 hours before start date) 

• RMC and GGA options for NMEA export feature; Trajectory convertor/interpolator moved from trajectory editor 
to the separate window. You can recall it using File->Export menu item. 

• Implemented new UI control for entering geographic coordinates in any suitable form. This control is used in 
Scenario Editor for entering start position and in the Waypoint Editor called from Trajectory Editor. 

• Implemented new UI control for entering ECEF coordinates. This control used in Scenario Editor for entering 
start position and in the Waypoint Editor called from Trajectory Editor. ECEF control and Geographic coordinates 
control linked together to sync values. 

• Fixed a bug in the File Manager where deleting a file leads to corrupt file list 

• Implemented RSG support functions (premium feature) 
o Includes the .traj file creator 
o RSG player for demo/test purposes 

 
Improvements in version 2.0 

• Fully supports the operation of multi-frequency simulation (simultaneous with the introduction of the model 
GSG-62) 

• File extensions can now be upper or lowercase 

• Improved management of trajectories. An example: 

o Time in NMEA files can be accepted as HHMMSS[.SSS] where [.SSS] are optional milliseconds. 
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• Improved management of KML files 
o Significantly improved resolution for trajectories built with route builder 
o Improved speed of communications with Google Maps Javascript API 
o Better handling of vertical trajectories 
o New feature allows change of speed and/or altitude for a range (or all) points 

• Improved trajectory interpolation. Some examples: 
o Better detection of end of trajectory segment 
o Better interpolation when speed is zero 

• Support for customer antenna models via upload to the instrument 

• Created an event for RELPOWER 
• Upon initiation of file upload, a memory check will verify enough space for the files 

• Improved scenario file management. Some examples: 

o Hour = 0 and/or minute = 0 are acceptable parameters 
o Better parsing of keywords and parameters 

Improvements in version 1.2 
• Fully supports the operation of GLONASS simulation (simultaneous with the introduction of the model GSG-56) 
• “Application Tips” available upon start-up of the software to guide unfamiliar users 

• The new “Build Route” panel generates a trajectory file from start / end locations similar to Google Maps “Get 
Directions” 

• Improved scenario management: 
o User can download the Navigation Data file for a given scenario from official web sites 
o “Auto” number of signals will provide as many channels as possible for that signal 
o Interference channels can be added to a scenario (GSG-55/56 only) 
o Scenarios can be specified as running “Forever” 

• Console tool improved and implemented loop command to log outputs repetitively. For example, if you want to 
see a log of an output during a scenario with frequency 1000 msec, just connect to device in the console tool 
and execute the command: loop 1000 sour:scen:log? To stop execution use appropriate toolbar button or press 
Ctrl+Z. 

• File Manager improves user messages, lost connection handling, selection of new PC folder 

• Added file management of RINEX observation files created by the simulator 

• Updated built-in scenario files 

Improvements in version 1.1 

• Improved trajectory management 
o Each waypoint can be edited to specify a unique altitude and speed value (in addition to the option of 

applying the same altitude and speed throughout the entire trajectory) 
o Waypoints can be interpolated at intervals from 1 hour to 10 times per second when converting a 

trajectory (check with the capability of the simulator for limitations of the hardware – some units may 
only have the ability to run a trajectory at 1 Hz) 

o Data can be opened and saved in csv, gpx, kml, and kmz formats 

• Improved scenario management: 

o Improved start position synchronization with selected trajectory file 
o In addition to default and download ephemeris files, user can now also select a specific file or files 

• Increased number of built-in files 
o 31 scenarios 
o 21 trajectories 
o 8 events 


